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Basics 
 

File and data types  
There are three main types of data that are used most commonly. These are: 

• Raster data: Geotiffs, netCDF etc.. The data are stored as points or pixels in a raster or array 

format. The file (e.g. xx.tif) contains a header which holds information about georeferencing, 

filename, size, resolution and number of layers (bands).  

• Vector data: The data are stored as geometries like points, lines or polygons, meaning that 

each vector element has a length, a shape, positions of start and end points etc. Unlike raster 

data, vectors can be compressed lossless as they do not have a resolution. In GIS, the most 

common vector file formats are shapefile and geopackage.  

• Delimited text: The data are stored in a tabular file format (.csv, .txt, .xyz, .xls, etc.). Text files 

with geo-related content contain coordinates (e.g. longitudes and latitudes) along with some 

data values (e.g. depth). They can be converted to raster (by interpolation or gridding) or shape 

files (e.g. sample points on a map), depending on what you want to display.  

 

 

Getting started with QGIS 
 

Create a new project  
 

After initializing QGIS you can open either a new empty project or a previously saved project. A 

general note: If you are missing panels or toolbars that will be mentioned throughout the manual, 

find and check them under ‘View’ -> ‘Panels/Toolbars’ or by right-clicking the icon bar and activating 

the tools (Figure 1). 

 

 
1: Make panels and toolbars visible 
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To keep things simple, select WGS84 as your project geographic coordinate system (GCS) (if not 

already set per default). You can do so by clicking on the Coordinate Reference System (CRS) symbol 

in the bottom right corner of the window footer. 

 

 

Working with Raster data 
 

Import a Raster 
 

Raster files like geotiffs or netCDFs can be added to the QGIS project via drag & drop. Of course, you 

can also add them via ‘Layer’ à ‘Add layer’ à ‘Add raster layer’ and navigate to your file.  

 

Once imported, check if the raster has a CRS. If you see a ‘?’ next to the raster layer, you need to 

assign one by either double-clicking the ‘?’ or right-clicking on the layer and under ‘Layer CRS‘, 

select the correct CRS. Note that by doing so, you are only assigning a CRS to the layer within the 

active QGIS project, you are not actually changing its geometry. Unlike vector layers, raster layer can 

be provided without a valid CRS. If this happens, it is mostly wiser to apply a reprojection using the 

respective tools. 

 

To keep things simple, use the latest GEBCO grid as an example and add it to the project by drag & 

drop. It is delivered with WGS84 as native GCS. The next step is to import some MBES bathymetry 

which is mostly provided with a projected CRS, such as UTM or World Mercator/EPSG3395. You can 

check out mangomaps to find out UTM zones. 

Changing colour scheme  
 

With colours, you can make any map looking either great and fancy or horrible. There are a few 

recommendations for scientific use of colour palettes – mostly with respect to colour blind people 

and also to match ratios of values to their respective colours. You can read more here about scientific 

colour maps. Below is a basic description of how to generally change the appearance of layers:  

 

• Double click on the layer to open its properties (Figure 2) 

• Under ‘Symbology’, select ‘Singleband pseudocolour’ via the dropdown menu 

• Leave ‘Band’ and ‘Min/Max’ values unchanged 

• Choose any colour ramp you like; if necessary, invert the colour ramp  

• There are more colour palettes:  

• Under ‘All Colour Ramps’ you will find all QGIS defaults and favourites 

• Under ‘Create New Colour Ramp’, you can check out the catalogue ‘cpt-city’ to find even more 

• You can even create entirely custom colour palettes selecting ‘Gradient’ or ‘Random’ under 

‘Create New Colour Ramp’ 

• To go wild and if the above mentioned are still not enough, you can import styles as .xml files 

e.g. from here or here. Make sure to cite accordingly.  

• Click ‘OK’ or ‘Apply’ if you want to stay in the properties  

 

https://mangomap.com/robertyoung/maps/69585/what-utm-zone-am-i-in-
https://www.fabiocrameri.ch/colourmaps/
https://www.fabiocrameri.ch/colourmaps/
https://plugins.qgis.org/styles/93/
http://doi.org/10.5281/zenodo.1243862


6 
 

 
2: Symbology menu in layer properties; set color ramp, blending and customize the layer appearance here. 

 

Create Contour lines 
 

An easy measure how to quantify depths or heights for is to draw contour lines, or isohypses / 

isobaths (lines of equal height/depth). Here is how to do it: 
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• In the Processing Toolbox, search for ‘Contour Lines’ 

• Select the GDAL tool ‘Contour’ 

• In the windows that pops up, select the raster you would like to draw contours from (e.g. 

GEBCO) as ‘Input Layer’ (Figure 3) 

• Choose an appropriate line distances; Note: Don’t set the intervals too small, as this can cause 

QGIS to crash if it is a large raster. For a global grid, e.g. GEBCO, a good interval would be 

1000 m  

• Click ‘Run’ 

• To label the lines, double-click the new line layer to enter its properties (Figure 4) 

• Under ‘Labels’, select ‘Single labels’ and under ‘value’, select the respective value field that 

contains the labels, in this case it’s the depth values for each contour line feature 

• For better visibility, you can check the ‘Draw text buffer’ in the ‘Buffer’ field 

 

 

3: Contour Line Tool dialogue 
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4: Label contour lines 

Create Hillshade 
 

Applying the 'Hillshade' algorithm can display raster DEMs (Digital Elevation Models) In 3D giving it 

an appropriate relief style. This is done by pretending that the vertically exaggerated surface is 

illuminated using different light-source settings, causing morphological features to cast shadows in 

certain directions. This however depends on the latitude and also on the coordinate system used, 

mostly geographic versus projected. You can find a table listing Z-factors (factor for vertical 

exaggeration) for geographic unprojected GCS (e.g. WGS84) below (Table 1). In this case, the Z-

factor is nothing else than meters expressed in degrees. For projected CRS (e.g. UTM or World 

Mercator), Z-factors are optional (because CRS units are usually equal to depth/height units), and can 

be set to 1. But you should check this visually. Check out the example images below (Figure 6). 

There are a few ways to apply hillshade, but the most commonly used and modern one is described 

below: 

• Colorize the raster you’d like to hillshade with the colour palette you like 

• In its properties under ‘Symbology’ and ‘Layer Rendering’, select ‘Multiply’ 

• Right-click the raster and hit ‘Duplicate layer’ 

• Double-click the duplicate and go to ‘Symbology’ 

• Under ‘Render Type’, select ‘Hillshade’ (Figure 5) 
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• Adjust the light source settings to your desired Altitude and Azimuth Enter the correct value of 

the Z-factor; as mentioned above, it is dependent on the latitude and the CRS (e.g. for 

unprojected GEBCO, chose 0. 00003) 

• Check ‘Multidirectional’ 

• Under ‘Layer Rendering’, you can also play around with brightness etc.  

• Optional (if you encounter pixelation): Under ‘Resampling’, select ‘Bilinear’ for in and out, and 

set ‘Oversampling‘ to 5 

• Click ‘OK’ 

• Make sure the hillshade layer is located underneath the raster layer used for colourisation in 

the layer tree 

 

 

 
5: Hillshading unprojected raster layer 
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Table 1: Z-factors for unprojected CRS 

 

  
6: Left: Correct Z-factor (0.00003) for hillshade for non-projected GEBCO grid, pixelation visible on the right. 

Right: Incorrect Z-factor (0.0003) for hillshade of non-projected GEBCO grid, pixelation visible on the right. 

 

Calculate Derivatives 
 

Derivatives are mathematical tools that give information about the change of a function at a given 

point. For DEMs, they highlight and describe morphological features and the most important are 

slope, aspect and curvature. Slope describes the angle of inclination (= rate of change of elevation 

for each cell in x, y direction) and is expressed in degrees or percent. Aspect groups cells based on 

their compass directions, hence gives information about the orientation of the steepest slope in a 

given neighbourhood. Curvature is the change of slope (the 2nd derivative) and expresses convexity 

and concavity of the terrain. Further measures are Terrain Ruggedness Index (TRI), which measures 

the difference of a central cell and its neighbours. Whereas Topographic Position Index (TPI) 

measures the relative difference in elevation between a specified central area compared to a 

specified surrounding area, revealing elevations and depressions. It is best practise to calculate all of 

these measures on projected DEMs where the units of x, y and z are equal (in meters at best, UTM is 

most accurate for these kinds of distance-based analyses). More information can be found here. 

https://gdal.org/programs/gdaldem.html
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There are several ways how to calculate the derivatives using QGIS tools. They all work kind of similar 

hence we’ll introduce one of them (Slope) and just mention the others:  

 

• In the Processing toolbox search bar, type ‘slope’ and find the tool GDAL/Raster Analysis -> 

‘Slope’ 

• This algorithm by default calculates slope based on a 3x3 kernel (moving window) 

• Select your DEM as input layer (Figure 7) 

• ‘Ratio of vertical units…’ is nothing else than the 1/Z-factor. If you work on a projected DEM 

(which you should), then leave it set to 1 

• ‘Compute edges’: Interpolate cells when missing data and at DEM edges. Leave this 

unchecked. 

• ‘Zevenbergen & Thorne’ (vs. ‘Horn’) formula: Z&T more suitable for smooth terrain 

• Select an output directory and a suitable name and hit ‘Run’ 

 

 
7: GDAL Slope dialogue 

Aspect, TRI and TPI work very similarly – just find them in the processing toolbox and click through 

the dialogs. They also per default use a 3x3 moving kernel size (= 9 neighbouring cells) per default. 

 

There is an all-In-one solution provided by the GRASS GIS core plugin that calculates several 

derivatives at once (slope, aspect, curvature). It is called ‘GRASS/Raster -> r.slope.aspect’ and 

accessible via the processing toolbox (Figure 8). If you can’t find the GRASS provider in the 
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processing toolbox, activate it by checking the ‘GRASS GIS Provider’ plugin under the ‘Installed’ tab 

in ‘Plugins’ -> ‘Manage and Install Plugins’. Open the tool dialogue and select the derivatives you 

want to calculate – there are options to calculate partial and second order derivatives as well and you 

may not need all of them. 

 

 
8: GRASS DEM derivative tool 

 

Working with Vector data 
 

Import existing Vector data 
 

Vector data can be anything but are mostly provided as ESRI Shapefiles (.shp), GeoPackage (.gpkg) or 

GeoJSON (.json). Both, '.shp' and '.gpkg' have multiple additional files containing metadata, without 

which they cannot be opened in most cases. Hence when moving or copying such data, it is 

important to copy all the files that belong to the main layer. To import an existing vector layer, you 

can just drag & drop the respective file into the ‘Layer’ panel of your QGIS project. You can also go 

via the ‘Layer’ menu, select ‘Add layer’ and ‘Add vector layer’ and navigate to your file. 
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Create a new Shapefile (point, line, polygon) 
 

Sometimes we want to create new layers from scratch to plan surveys, set sampling locations etc. 

Find the instructions below: 

 

• At the top panel, under 'Layer' go to ‘Create Layer’, and select ‘New Shapefile Layer’ in the 

dropdown menu (Figure 9) 

• Navigate to the folder where you want to save the shapefile to via the “…” button and enter a 

(reasonable) name 

• Select the geometry type you want to create (polygon, point, line) 

• You can add new columns here but you can always do that later as well 

• Leave everything else as default and press 'Ok' 

• Right-click on the layer or press the 'Toggle Editing' icon  in the upper panel to activate 

editing mode. 

• Now select the ‘Add X (polygon, line, point) Feature’ icon  ('Add point feature') to the right 

of the pencil icon.  

• You can now draw lines or polygons and set points anywhere on the canvas. 

• Once you’ve created your feature, a new window will open and asks you to enter an ID; this can 

be any integer number but you may want to give it reasonable numbering. If you created other 

fields, such as coordinates, you can now populate them here, too. 

• Once you're done, untoggle editing mode by pressing the pencil icon again and save the edits. 

 

 

Drawing a Polygon Bounding Box with given coordinates 
 

It is not straightforward to mark an area with a polygon bounding box using a set of given coordinates 

– you have to take a slightly more indirect route here. As a first step, we’ll draw points to a point layer 

and snap the polygon edges to those points in a second step. You’ll need a plugin ‘Lat Lon Tools’, a 

point layer and a polygon layer: 
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• Under ‘Layer’, click ‘Create New Temporary Scratch Layer’ and chose ‘Point’ as ‘Geometry 

Type’ 

• Use the ‘Lat Lon Tools’ plugin (see chapter “Working with Plugins”) to add features by typing 

the bounding box coordinates 

• You should see your points on the map 

• Now create a new polygon layer 

• Enable snapping: Under ‘Project’ and ‘Snapping Options’, select ‘All Layers’ and ‘Snapping on 

Intersection’ 

• Now draw any polygon anywhere on the canvas in the polygon layer 

• Enable the ‘Vertex Tool’ in the upper panel  

• Drag and snap the polygon’s corner to the points 

 
9: New Shapefile Import dialogue 

 

Add Coordinates of Points in Vector layer 
 

Each vector layer has an associated attribute table that holds information about all features 

contained within that layer. This table can be populated with new fields and values for any kind of 

information. Here is how to add coordinates to the attribute table for each point of a point shape file: 
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• Open the attribute table by right-clicking on the layer or find the respective icon in the toolbar 

 
• Toggle editing  

• Make sure to either select or deselect all lines  

• Open ‘field calculator’ by pressing the calculator icon  or use the keyboard shortcut 

‘cmd/Crtl+I’ 

• On the left side of the field calculator window (Figure 10), tick ‘Create a new field’ -> Give it a 

reasonable name (e.g. Longitude/Latitude) -> chose field type ‘Decimal’ -> set the ‘output field 

length’ to 10 with precision 4 (= significant numbers, 4 is enough for bridge file) 

• In the expression field, type ‘$x’ for longitude or ‘$y’ for latitude and hit ‘OK’ 

• A new column should show up with Longitudes or Latitudes, respectively 

• Deselect all lines/fields (otherwise your entries will vanish for some reason) and click the little 

pencil icon for untoggling editing; answer ‘Save’ when asked 

 
 

 

10: Get coordinates using expression 

 

Add Names and Dates to points in Vector layer 
 

Similar to the procedure above, you can add columns with text or date fields, to describe or comment 

your sample locations: 

 

• Follow the first 3 steps from the Add Coordinates of Points in Vector layer section 
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• Open ‘New Field’ by pressing the icon or use keyboard shortcut 'Ctrl+W' 

• Choose a name 

• Select ‘Text (string)’ or ‘Date’ from the ‘Type’ – drop-down menu 

• Click ‘OK’ 

• You can now enter comments or dates in the new column/s  

 

 

Coordinate Conversion 
 

Sometimes we need coordinates in a different format. Following a similar approach as before, we 

can easily do coordinate conversions between different formats:  

 

• In the attribute table toggle editing mode, select or deselect all lines and open the ‘Field 

calculator’ 

• On the left side of the field calculator window, tick ‘Create a new field’ -> Give it a reasonable 

name (e.g. Lon_deg or Lat_deg, respectively) -> choose ‘Text (string)’ -> set the ‘output field 

length’ to 15 

• In the expression field, type to_dm( "Lat" ,'y','3','suffix') where in ”” you type the name of the 

column which you would like to convert (i.e. when your column containing latitude coordinates 

is called Lat, then type “Lat”; Figure 11) 

• A new column should show up with the coordinates in degree and decimal minutes 

• Deselect all lines/fields (otherwise your entries will vanish for some reason) and click the little 

pencil icon for untoggling editing; answer ‘Save’ when asked; 

• Important Note: If your edits vanished after saving, you need to do it again. It’s a bug in QGIS. 
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11: Convert Coordinates using expression 

 

Automatically populate fields with attributes 
 
You can set default values for the attribute field that are filled when new features are added to a 
vector layer. The default is ‘NULL’, but you can change this to anything. E.g. if you add a point and 
would like the coordinates to be written to the layer’s attribute table automatically, you can do so: 
 

• Go to the layer properties by double-clicking on the layer and find the ‘Attributes Form’ tab 

(Figure 12) 

• Under ‘Available Widgets’, find ‘Fields’ and click on the field you want to set the defaults (if the 

field doesn’t exist yet, create it in the attribute table) 

• Under ‘Defaults’, enter the expression you want to set as default. For instance: ‘to_dm($y, 'y', 

'4', 'suffix')’, if you want to write the coordinates in degree, minutes 

• Make sure you check 'Apply default value on update' to apply this to every ID that Is added to 

you’re attribute table  

 



18 
 

 
12: Set default field values 

 

Working with delimited Text Data 
 

Import existing files 
 

Delimited text layers can be anything, from lists with samples or stations to survey coordinates. To 

import them to QGIS and in order to geolocate the data, they need to contain coordinates 

somewhere and they should be formatted uniformly – meaning that each column is separated by the 

same symbol for each line, the coordinates are in uniform CRS etc. QGIS has a very convenient import 

tool which is described in the following: 
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• At the top panel, go to ‘Layer’ -> ‘Add Layer’ and select ‘Add delimited text layer’ 

• In the dialogue window (Figure 13), navigate to your file by pressing the “…” button 

• If needed, under ‘File Format’, select the correct separator (e.g. ‘;’ or ‘tab’) 

• If you have unnecessary header lines (e.g. for CTD files), then you can skip them in the next 

panel under ‘Number of header lines to discard’ 

• To keep the field (i.e. column) names from the imported data source, you can do so by checking 

‘First record has field names’ 

• You should now see a reasonable preview of your file in the lower panel with each field 

containing one column and its values 

• Under ‘Geometry Definition’, select the correct fields for longitude and latitude (and optional 

value):  

x-Field: Longitude 

y-Field: Latitude 

z-Field: Value (optional): useful If you want to display and colorize a specific parameter of 

measurements at the different locations (e.g. If you want to look at the salinity measurements 

you choose the column with the salinity values from your data here)  

• For unprojected geographic coordinates, select WGS84 in the Geometry CRS dropdown menu 

• Click ‘Add’ and ‘Close’ (If ‘Add’ button is greyed out, there might be something wrong with the 

geometry settings) 

 

 

 
13: Import delimited text file dialogue 
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Export delimited text as vector and vice versa 
 

With delimited text files, there is limited options concerning styling, labelling etc. compared to 

vector data. Hence, they sometimes need to be converted to vector format such like shape files or 

similar (e.g. geopackage (.gpck)). It is very simple: 

 

• Right-click the vector file you want to export 

• Select ‘Export’ -> ‘Save features as…’ (Figure 14) 

• Depending on the source data and the target format, either select ‘Comma Separated Value 

(CSV)’ as format, ‘GeoPackage’ or ‘ESRI Shapefile’ or anything else as file format 

• Navigate to the output folder and enter a reasonable file name (Note: If you don't navigate to 

a specific folder QGIS saves the file to some default folder you will never find again) 

• Click ‘OK’ 

 

 
14: Export as... dialogue 

 

Feature Selection/Filtering 
 
Filtering is an essential method for data exploration – especially if you have messy, unstructured or 
non-uniform data. There are multiple filtering options, the most straightforward one is via a layer’s 
attribute table. The following will be based on the example of the global EEZ layer taken from 
marineregions:  
 

https://www.marineregions.org/eez.php
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• Open the attribute table of a vector layer (either right-click the layer or click the ‘table’ icon in 

the icon bar) 

• In the upper panel of the attribute table, click the ‘Select/filter features using form’ icon (or 

'Ctrl/Cmd + f') which opens a new filter form (Figure 15) 

• In the respective field, enter the attribute value that you would like to filter by. There will be 

suggestions according to existing attributes 

• Choose the desired operation from the dropdown box next to each field.  Per default it is set 

to ‘Exclude field’. It changes automatically to an appropriate option once an attribute value is 

entered.  

• Example: Using the provided EEZ layer, in the field ‘LINE_TYPE’, type ‘200 NM’ (you should 

see ‘200 NM’ appearing below). The dropdown box next to it should have switched to 

‘contains’ – translated, this means you will filter for all features that contain ‘200 NM’ in their 

‘LINE_TYPE’ attribute field. Click ‘Select Features’ and you should see them highlighted. 

• You can also select features by multiple attribute values by chaining selections: Click the arrow 

next to ‘Select Features’ and add/remove additional attribute values. 

• Example: Now enter ‘Unsettled (maritime)’ in the ‘LINE_TYPE’ field and press ‘Add to Current 

Selection’. You should now see all features with ‘200 NM’ and ‘Unsettled (maritime)’ 

highlighted. Spoiler: This covers almost all the 200nm Zones. 

 
 

 
15: Filter features using form 

 

Label Data 
 

Labelling data can help adding important information to a map – but it can also quickly overload a 

design. Try to avoid unnecessary labelling. The procedure described here works for vector and 
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delimited text and uses fields from the layer’s attribute table for automatic labelling. There are very 

sophisticated methods for labelling, we’ll stick to the basic, most used one here: 

 

• Right click on the layer to label to open its ‘Properties’ (Figure 16) 

• Under ‘Label, select ‘Single Labels’ 

• For ‘Value’, select the field from the attribute table that contains the labels 

• Chose colour, font and style in the ‘Text’ and ‘Formatting’ fields  

• You can also draw a buffer (in the ‘Buffer’ field) to make the labels more visible 

• If you have curved lines like e.g. contours, it can make sense to also curve the labels. You can 

do so in the ‘Placement’ field with ‘Mode’ set to ‘Curved’ (Figure 16) 

• If you only want to display labels at a certain scale, adjustments can be done in the 

‘Rendering’ field 

• There are many ways how to style labels, there’s also the option of smart rule-based labelling 

– check them out! 

 

 
16: Labelling dialogue - Mode 'Curved' 

 

Clip Features 
 

Clipping raster or vector layers can be very useful, not only to reduce file size but also to concentrate 

on the main focus and many other reasons. QGIS provides different clipping options. 
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Clip Raster/Vector file from mask layer/extent 
 

• In the toolbox , enter ‘clip’ in the search field or under raster/vector, respectively, find the 

‘Clip by mask layer’/‘Clip by extent’ tool. You can use the proprietary tool or the GDAL.  

• For ‘Clipping by mask layer’: Select the layer you want to clip as ‘input layer’ and the mask (the 

regions you want to cut off) as ‘overlay layer’ 

• For ‘Clipping by Extent’: Select the layer you want to clip as ‘input layer’ and click the “…” 

button next to ‘Extent’ to select the layer, which you want to take the extent from 

• This works for both raster and vector data. 

 

Georeferencing 
 

Georeferencing is the assignment of coordinates to an image without CRS. This can be any image. 

To add for example a screenshot of a map to your project, you could use georeferencing to place it 

to its geographical location. You can also georeference vector data, but we’ll stick to raster for now. 

The basic procedure is to add Ground Control Points (GCP) to match features from the image to the 

real map: 

 

• In the menu bar, under ‘Layer’ select ‘Georeferencer...’ and click the ‘open raster’ button 

• Remember: If the Georeferencer tool is not visible, activate it in the ‘Installed’ section of the 

‘Plugins’ dialogue (see chapter “Working with Plugins”) 

• In the new window (Figure 17), import the image to be georeferenced 

• Then click the ‘Add Point’ button which enables you to enter GCPs 

• On the image, pick a point which is easy to recognise, such as prominent features, sea- or 

landmarks. Find the exact same location on the map and click on the spot 

• In the ‘Enter coordinates’ dialogue, either select ‘Add from canvas’ which automatically takes 

over the coordinates from the clicked spot on the map or enter the coordinates manually 

• Repeat this several times – the more points and the further apart from each other, the more 

precise will be the result. It Is recommended to at least assign four GCPs, one at each image 

corner. 

• Once you're finished, click the ‘Setting’ wheel icon: 

• Select ‘Linear’ as ‘Transformation Type’ 

• ‘Nearest Neighbour’ or ‘Thin Line’ as ‘Resampling Method’  

• Chose the target CRS 

• Hit the ‘Play’ button 

• You should now be able to see the image on your map – if it is distorted, go back and modify 

the GCPs 

• To get rid of the black frame, open the new layer’s properties: 

• Under ‘Transparency’ and ‘Transparency Pixel List’ click on ‘Add values from display’ (pointer 

with ‘?’)  

• Click on the black frame (or any unwanted colour) on the canvas 
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17: Georeference an image 

 

Working with Plugins 
 

QGIS’ processing toolbox is great, but even with all its tools, it is sometimes not enough. Luckily, 

QGIS is open to any development and facilitates to use plugins in addition to the toolbox (Hint: If you 

have a cool idea, you can even write plugins yourself.). You can install any plugin via the top panel, 

under ‘Plugins’ go to ‘Manage and Install Plugins’ either using a pre-downloaded .zip file or directly 

from the catalogue (Figure 18: Plugin dialogue: Find, activate and deactivate plugins8). If you can’t 

see a plugin although you have installed it, activate it by checking the box next to the respective 

plugin in the ‘Installed’ list. 

 

 
18: Plugin dialogue: Find, activate and deactivate plugins 

In the following we’ll introduce some of the useful plugins for marine science. 
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Profile line tool 
 

• To start the tool, click the ‘Profile’ symbol 

• In the layer side bar, select the layer that you want to take a profile from (e.g. GEBCO or any 

DEM) and click ‘Add Layer’ 

• You can also select multiple layers for comparison 

• Now click In the map on a start and an end point of the profile and lines should appear in the 

lower window (Figure 19) 

• You can also export the created line by clicking on ‘Save as’  

 

 
19: Profile Tool window 
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PosiView  
 

PosiView is a very neat tool to visualise real-time position of e.g. a ship and e.g. an OFOS or ROV 

directly on the map canvas. It works best with an ethernet connection via UDP protocol. 

• Initiate PosiView by clicking the PosiView icon   

• To set things up, click the toolbox icon ‘Configure PosiView’ and go to the ‘Position Provider’ 

tab (Figure 20) 

• The ‘Position Provider’ is the device on the platform that delivers position data, mostly as 'nmea 

strings'. If you want to set up PosiView to indicate the vessel position, name it after the vessel, 

e.g. ‘R/V SONNE’ 

• Under ‘Provider Properties’, enter the correct information – if you don’t know what to enter 

here, ask your WTD 

• For R/V SONNE, this is:  

• Type: UDP 

• Host: 0.0.0.0 

• Port: 7150 

• Parser: None 

• Press ‘Apply’ 

• Now go to the ‘Mobile/Vehicles’ tab (Figure 21). Here are several things to add: 

• With the ‘+’ sign create a new mobile and name it after your vessel  

• Choose which shape the tracking point should have (box, cross, circle, etc.) under ‘Type’ and 

set length, colour and forward track (play around a little with the settings) 

• You can also set the label to ‘visible’ 

• Under ‘Provider Filter’, select the vessel you’ve created from the dropdown menu 

• The ‘Data provider’ needs to be the same as in the ‘Provider Filter’. To do so, click the button 

with the green arrows on the right 

• Click ‘Apply Properties’, ‘Apply’ on the bottom page and close the window 

• Click the play symbol next to the ‘PosiView’ icon in the upper panel 

• You should be able to see R/V SONNE’s position on the map now 

• To add a an observation gear or vehicle such as OFOS or ROV, repeat the above procedure 

setting the correct protocols and ports and using the correct position provider. If successful, 

you should see two position points on the map. 

 

Disclaimer: Unfortunately, PosiView does not always work the way we hope. So, if it doesn’t work it is 

not necessarily your fault. Just try again, play around with possibly some timeout settings in the ‘Mo-

bile/Vehicles’ Header discussed above and see if it helps. 
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20: PosiView Position Provider 

 
21: PosiView Vehicles 
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Create A Map Layout 
 

Creating nice maps can be a challenge and it’s not for nothing that there are entire study programs 

dealing with map designs. It’s easy to lose yourself in details here and, that said, the following guide 

is not meant to create award winning map designs, it shall rather help to gain an overview of how to 

make a basic map (like e.g. Figure 22). If you’re interested in map design, this guide by mapbox might 

be a good start. 

 

 
22: Example Basic Map 

 

Create a Map Layout 
 

A proper map contains a coordinate frame, a scale bar, a legend, information about projection and 

the reference coordinate system, maybe authors and date of creation and of course the data 

themselves. Here is how to create a printable map:  

 

https://www.mapbox.com/insights/map-design-process
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• In the menu bar, under ‘Project’ click ‘New Print Layout..’ and give it a name 

• To add a map, under ‘Add item’, select ‘Add map’ and draw a rectangle on the canvas 

• On the right panel, find the ‘Item Properties’. You can change scale, projection, styles etc. here 

– for now make sure, that the ‘CRS’ is the same as the CRS of your QGIS project, e.g. ‘EPSG3395 

– World Mercator’.  

• To change zoom and extent manually, click the move icon ( ) and drag & drop or zoom 

directly in the layout map 

 

 

Add a Coordinate Frame 
 

The following will describe how to add longitude and latitude, hence unprojected, geographic 

coordinates. You can of course add any CRS, but this guide will stick to the basic WGS84.  

 

• In the ‘Item Properties’ of the ‘Map1’ layer on the right panel, scroll down until you find the 

‘Grids’ section (Figure 23) 

• Add a new grid by pressing the ‘+’ button and click ‘Modify Grid’ 

• Under ‘Grid type’, chose your favourite style 

• Set ‘CRS’ to ‘EPSG4326 - WGS84’ to get the coordinates in latitude and longitude and set 

‘Interval’ to ‘map units’ (i.e. degree) 

• For ‘X’ and ‘Y’, respectively, select a reasonable tick/annotation interval in map units (e.g. 10 of 

you would like to have ticks and annotations every 10 degrees) 

• Select a frame style and a frame should appear around the map  

• Note: If the coordinates or the frame look weird, there is something wrong with the projection 

you’ve chosen. 

• To add coordinates, scroll down and check ‘Draw Coordinates’ (Figure 24). Then select the 

annotation style for each edge in the respective drop-down menu. 

 

 
23: Add a grid 
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24: Add coordinates 

 

Add Scale Bar 
 

• Under ‘Add Item’, select ‘Add Scale Bar’ 

• Mark the area for the scale bar in the map by drawing a rectangle 

• You can change appearance and other properties in the ‘Item Properties’ tab 

 

 

Add a Legend 
 

• Like before, under ‘Add Item’, select ‘Add Legend’ 

• Mark the legend position in the map by drawing a rectangle and the legend will automatically 

appear and be placed here (Figure 25). 

• The default setting is ‘Auto update’, meaning that the legend is automatically updated to what 

changes on the main map canvas (QGIS project); uncheck for manual editing 

• Use the ‘+’ and ‘-’ buttons to add or delete legend entries 

• Double-clicking on an entry lets you change the entry’s properties  

• There are a lot of settings here like different fonts, backgrounds, frames, annotations etc. You 

can also edit the depth colour bars (Figure 26). Play around with it to make your legend look 

fancy! 
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25: Map legend – before editing 

 
26: Edited colour bars in map legend 
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More Info 
 

QGIS map layout is a very powerful tool that allows you to design very specific customized maps– from 

adding pre-defined shapes like rectangles and circles, labels, north arrows, additional maps to creating 

inlays and much more. You can also add custom images. In the ‘Item Properties’, you can always change 

styles and properties at any time. Save styles to your favourites to re-apply them to other layouts or 

save entire map templates for further projects under ‘Layout’ and ‘Save as Template’. Map layouts can 

be exported to different file formats e.g. pdf, jpeg or geotiff with the option to create a world file for a 

georeferenced map.   

 

 

The Long and Odd Story of Coordinate Systems and Projections 
 

Projections and coordinate systems can be a true pain if you’re not familiar with it. The basic concept 

for CRS in QGIS is that each QGIS project is assigned to a CRS or GCS. This can be WGS84 – non-

projected GCS - or anything else like World Mercator or UTM (projected CRS). Note: This assignment 

is for the visualisation of your map canvas only and doesn’t change the geometry of the layers you add. 

Hence, keep in mind: Assigning a CRS in QGIS refers to visual aspects only. Reprojecting however 

changes the geometry of a layer. Any layer can have different default projections depending on its 

creation – you can add a layer in UTM projection to a QGIS project in WGS84 and everything will be in 

place. More information can be found here. 

 

Select Projection for the QGIS Project 
 

• In the main menu, under ‘Project’ go to ‘Properties’ and ‘CRS’  

• Uncheck the first box ‘No CRS …’ otherwise you won’t have any reference coordinate system 

• For most tasks, selecting ‘WG84’ as coordinate system is fine. Note that WGS84 only is not a 

projection, just a coordinate system! 

• For a projected map (i.e. when measuring distances, calculating areas etc.), select a projected 

CRS such as ‘UTMXX’ 

• You can switch between CRSs by clicking the world icon  in the bottom right corner of the 

GIS project. 

 
 

Assign Projection for Single Layers 
 

• Right-click on a layer, go to ‘Select CRS’ and choose any of the proposed CRS  

• This is especially relevant if you for example import a projected raster such as e.g. a bathymetry 

grid in UTM29. The assigned layer’s CRS must be the same as the layer’s projection. If the layer 

is not displayed where it should be, then either assign the correct CRS or reproject it to the 

https://docs.qgis.org/3.34/en/docs/training_manual/vector_analysis/reproject_transform.html
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respective CRS. Remember: Assigning is for visualisation only, reprojecting changes a layer’s 

geometry.  

• Try it out: Assign a different CRS than the layer’s proprietary and you shouldn’t be able to see 

the layer anymore at the same position. 

 

Reproject Single Layers 
 

As mentioned before, reprojection changes a layer’s geometry.  

It is applicable for raster and vector data and is required for distance or area calculations, as well as for 

applying morphometric terrain analysis tools. Here is how: 

 

• In the ‘Processing toolbox’, find ‘GDAL/ Reproject (Warp)’ (for raster) or ‘Vector 

general/Reproject layer’ (for vector) 

• Select an input file  

• Define source (e.g. WGS84; only for the GDAL tool) and target (e.g. UTM29) projection  

• Hit ‘Run’ 

 
 

Select a Projection in Map Layout and Map Frame Coordinates 
 

The map layout should usually have the same coordinate system and projection as your project. 

Remember: For coordinates displayed as longitudes and latitudes in degrees around the map frame, 

select ‘WGS84’ in the grid properties. 

 

Generally, if things start to look weird (e.g. one layer is in a complete non-realistic scale or location, or 

if the map frame annotations have unlikely intervals or no intervals at all, e.g. Figure 27) this is usually 

caused by messed up projection parameters. Go and check your project’s properties, layer CRSs and 

map layout as well as the grid CRS settings! See below for typical examples of projection failures (Figure 

28). And don’t worry – we’ve all been there!  
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28: Scaling failure 

27: Incorrect coordinate notation 
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Expressions 
 

QGIS Expressions are a built-in method which is very powerful and can be used on any vector layer to 

do almost anything you want, such like filtering, selecting, visualising, labelling etc. It can e.g. be 

accessed via the ‘Field Calculator’ in the ‘Processing Toolbox’ , in the properties of vector layers or 

within the attribute table of a (vector) layer etc. Whenever you spot a symbol like these: , it’s 

the ‘Expression builder’ behind it. 

The ‘Expression builder’ uses a SQL-like QGIS proprietary script language which basically calls a 

function first that embraces some variables and methods. Some useful expressions are introduced 

below, although it shall be pointed out that there are many more useful expressions.  

 

 

Aggregate Function 
 

The aggregate function can be used to combine attribute values from other layers to the working layer. 

Imagine for example you have a point vector file containing seamount positions and a polygon file with 

a swath coverage of a multibeam track. You would like to sum up all the seamounts within an area that 

intersects with the swath coverage. You can do so using ‘Aggregate’: 

• Right-click the swath coverage layer to open its attribute table 

• Toggle editing mode 

• Open the field calculator 

• Depending on whether you want to use an existing column or not, let the box ‘Create a new 

field’ checked or uncheck it and check ‘Update existing field’ 

• Give reasonable formatting (e.g. integer or decimal for calculations) 

• Enter the following expression (make sure you adapt ‘layer’ and ‘expression’ according to your 

layers and naming): 

 
aggregate( 

layer:='all_seamounts — all', 

aggregate:='count', 

expression:="field_5", 

filter:=intersects(@geometry, geometry(@parent)) 

) 

 

Note: In the above function, ‘layer’ refers to the layer that contains the information that you want to 

aggregate (e.g. seamounts), ‘aggregate’ is the aggregation method, ‘expression’ refers to the field in 

the ‘layer’ that you want to aggregate and under ‘filter’, you can add the method how the actual layer 

and the aggregation layer should relate (i.e. aggregate where they intersect etc.). In the case of using 

‘count’ as aggregation method it doesn’t matter what field you enter next to ‘expression’ because it’s 

just a feature counter and you need to enter something here. If you use a different aggregation method, 

e.g. ‘sum’, ‘min’ or ‘max’ you need to enter the field containing the values you want to sum up here. 

Imagine you want to know the seamount with the minimum depth below sea surface, the expression 

would be like below (because ‘field_5’ contains the depth values of the seamounts): 
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aggregate( 

layer:='all_seamounts — all', 

aggregate:='min', 

expression:="field_5", 

filter:=intersects(@geometry, geometry(@parent)) 

) 

 

The new field should be filled with the depth of the shallowest seamount within the coverage for each 

feature. You can also use this expression to e.g. set a default value for a field. To do so: 

 

• Double-click the vector layer to open its properties 

• Go to ‘Attribute form’ and find your field under ‘Available Widgets’ 

• On the right, under ‘Default’, hit the ‘sum’ button 

• The next steps should be familiar, they are the same as above: Like before, enter the expression 

in the expression field and click ‘ok’ (Figure 30) 

• Check the box ‘Apply default value on update’ 

 
Now if you add a new polygon, the field should be automatically filled with the sum of all seamounts 

within the polygon area.  

There are of course more useful aggregation functions like average, min, max (numerical) or 

concatenations for string analyses. Go try them out! 

 

 

30: Use 'Aggregate' Function in Field Calculator 
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Categorising with CASE … WHEN Expression 
 
Imagine a shapefile having multiple features with different values for an attribute. Take for example the 
seamount shapefile that contains charted and uncharted seamounts with given depth along with more 
information. Now we want to roughly categorise them into the depth boundaries hadal, bathyal, etc… 
- here is how it can be done (Figure 31): 
 

• Open the attribute table of the seamounts layer and make it editable 

• Open the field calculator and add a new field (e.g. ‘Category’), select ‘Text’ as output format 

and set the output field length to ‘20’ 

• Now enter the following logic in the expression field (here, “field_5” contains depth values): 

CASE  
WHEN "field_5" < '-6000' THEN 'Hadal' 
WHEN "field_5" < '-4000' THEN 'Abyssal' 
WHEN "field_5" < '-2500' THEN 'Bathyal' 
WHEN "field_5" < '-1000' OR  
 "field_5" < '-100' THEN 'Coastal' 
END 

• If you are a little familiar with coding, this is nothing else than an if-else loop: If below or 

between certain depth values, set the category to the appropriate value 

• Note: Make sure that “field_5” contains valid depth values 

 

 
31: CASE/WHEN (if-else) logic 
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Advanced Filtering using Expressions 
 
Recall from the Feature Selection/Filtering section how to select features using the attribute table. The 
‘Select/filter features using form’ (Figure 15) builds expressions from what has been entered in the value 
field for filtering. Which means – you can build these expressions yourself to filter and/or select features! 
Here is how (Figure 32): 
 

• Repeat steps 1-5 from the Feature Selection/Filtering section 

• Now instead of clicking the ‘Select features’ button, press ‘Filter Features’ next to it. 

• You should see a field at the bottom of the windows showing something like ‘("LINE_TYPE" 

ILIKE '%200 NM%')’ – translated, this means nothing else than before: ‘Filter features whose 

LINE_TYPE attribute contains 200 NM’ and is the QGIS expression for this operation. ‘ILIKE’ 

means something like ‘contains’ and is a logical operator (just like ‘=’). 

• Press ‘Apply’ 

• You should now only see the filtered features in the attribute table (Note that they are not 

highlighted like when selecting features!) 

• If you want to filter by multiple values, you can chain selections using ‘OR’: 

• ("LINE_TYPE" ILIKE '%200 NM%') OR ("LINE_TYPE" ILIKE '%Unsettled (land)%') 

• Note: It might be better to use the ‘Expression builder’ here: Next to the field on the left 

windows side, find the ‘Advanced Filter (Expression)’ button and open the ‘Expression builder’. 

You should see your query already in here. 

 

 
32: Filter by Expression 
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Labelling using Expressions 
 
If you don’t want to have a label on each feature of your layer, you can smart-label by using expressions 
and/or rule-based labelling: 
 

• In the layer’s properties, open the ‘Label’ tab 

• Select ‘Rule-based’ labelling 

• Example: For the EEZ layer, add a rule by clicking the ‘+’ sign and click the ‘Edit Rule’ button. 

In the ‘Filter’ field, add e.g. "LINE_TYPE" ILIKE '%200 NM%' and click ‘Test’. You should see a 

window saying ‘XX Features found’. If you apply this rule, only features matching this filter 

should appear as labels. 

 
 
 

Symbology using Expressions 
 
Analogous to the labelling, you can apply rule-based symbology by simply entering the same rules like 
above in the ‘Symbology’ of the layer properties (Figure 33). You should see only features matching the 
filter/s on the map canvas. 
 

 
33: Rule-based Labelling/Symbology 
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Model Builder 
 

We will introduce a new concept called the model builder. The model builder facilitates chaining 

several tools together – e.g. if you need several DEMs to all go through the same processing pipeline, 

then using the model builder can be very helpful. You can build a pipeline such that the output of one 

processing step can go straight into the next. You can also create layers from all processing steps if 

necessary. We’ll use the model builder to calculate the Topographic Wetness Index (TWI) for a DEM as 

an example. Important note here: This is mainly an exercise to introduce the model builder and doesn’t 

claim to give a perfect terrain analysis. It’s adapted from here. If you would like to use the tool presented 

in the following section scientifically, please do some further research on which parameters to set how 

to select them. 

 

TWI is a measure used in terrestrial morphological analysis to estimate water accumulation areas. (In 

marine science, a possible use could be to derive flow velocities and sedimentation regimes from 

accumulation areas.) It is based on slope and the upstream contributing area:  

 

TWI = ln(a/tan(b))  where  a= upstream contributing area (m2) 

    b = slope in radians  

     

The Model builder will need the GRASS GIS processing tools. If not yet implemented, activate the 

GRASS tools like described in the Calculate Derivatives section. 

 

Here is the processing chain for calculating TWI with the model builder: 

 

• In the top panel of the processing toolbox, find the ‘gearwheel ‘icon (Figure 34) and select ‘Add 

new Model’ 

 

 
34: At the very left find the gear Wheel Icon to open Model Builder 

https://courses.gisopencourseware.org/mod/book/tool/print/index.php?id=41#ch66
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• First of all, you’ll need to define the input layer (Figure 35): On the left side under ‘Inputs’, 

double-click ‘Raster layer’ and enter a suitable description (e.g. ‘DEM’) 

• Now you need to fill gaps, if any, in your DEM: In the ‘Algorithm’ section, find ‘GDAL/Raster 

Analysis -> Fill Nodata’ and drag & drop to the centre canvas (or double-click) 

• In the window that has opened, under ‘Input Layer’ select ‘Using Model Input‘ and ‘DEM’. This 

automatically takes the output of the previous model step as input (Figure 36). 

• If you want, you can create an output layer here. To do so, scroll down and enter a reasonable 

output name (something like ‘filled’, for example) 

• If the data contain larger voids (data holes), play around with the other parameters, else leave 

them as they are  

• Next, do the same for ‘GDAL/Raster Analysis -> Slope’. Make sure to select the previous 

‘[…]_filled’ layer as input here: If you want slope as an extra layer, name the output e.g. 

‘slope_nozero’  

• Now we need slope in radians and to do this, each cell needs to be multiplied by: 

2*p/360° = p/180° ~ 0.0715 
• Like before, use the GDAL raster calculator to apply this conversion to the ‘slope_nozero’ grid 

(Figure 37) 

• Find the ‘GDAL Raster Calculator’ in the ‘Algorithm’ section and select ‘slope’ as input. It will 

be referred to as ‘A’ later on in the equation 

• Type ‘1’ into the ‘Band number’ field 

• In the ‘Calculation in gdalnumeric…’ field, type: 

A * 0.0715 
to assign convert degree to radians 

• Name the new output ‘slope_rad’ 

 

• Now calculate the flow accumulation based on the filled DEM: 

Find the ‘GRASS/Raster -> r.watershed’ tool and select the ‘filled’ layer as input (Figure 38 

• ). 

• Set ‘Max. size of exterior watershed …’ to ‘500’ (cells), check ‘Enable Single Flow Direction (D8) 

…’ and check ‘Beautify flat areas’ 

• Leave everything else as the default and, if wanted, name the output ‘Number of drain …’ 

‘accumulation’; we won’t use the others, you are of course free to output them all 

• Eventually, the TWI can now be computed (after Beven and Kirkby, 19791): 

• Again, use the ‘Raster calculator’ to apply the above-mentioned equation by using the 

generated layers and the cell size (here 100m). Note that ‘A’ refers to the drainage layer and 

‘B’ to the slope in radians. We further need to add a small value to the slope to avoid zeroes in 

the denominator: 

log ( ( abs(A) * 100 * 100 ) / tan ( B + 0.000001 ) ) 
 

 
1 Beven, K. J., & Kirkby, M. J. (1979). A physically based, variable contributing area model of basin hydrology / Un modèle à 
base physique de zone d’appel variable de l’hydrologie du bassin versant. Hydrological Sciences Bulletin, 24(1), 43–69. 
https://doi.org/10.1080/02626667909491834 

https://grass.osgeo.org/grass84/manuals/r.watershed.html
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The model should now look somewhat like Figure 39 

.  

• Now all you have to do is press the ‘Play’ button in the upper right and select your input DEM. 

You can switch on and off the output layers if you don’t need to see them all. The rest should 

run automatically!  

• Another very useful thing about the model builder is that you can export the entire model as a 

python script which can be imported to any python codebase. Just press the ‘Export as Script 

Algorithm’ button in the upper panel of the model builder.  

 

 
35: Define model input 
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36: Model Builder: add a function 

 
37: GDAL Raster Calculator inside model builder 
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38: GRASS watershed tool 
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39: Final Model 

 

Tiling and Compression 
 

Representing and visualising large datasets can be a very CPU-intensive task. Online map services like 

Google therefore came up with the idea of tiling – dividing a map into (mostly) squares to be able to 

load them faster. This requires the map to be projected and most commonly, Mercator projections are 

used here, such like Pseudo- or Spherical Mercator (EPSG:3857). Raster tiling then works by calculating 

pixel coordinates at defined zoom levels. Multiple distinct zoom levels then form a pyramid with the 

top zoom level (zoom=0) that represents 256x256 pixels (one tile), 512x512 at zoom=1 (four tiles), 

1024x1024 at zoom=2 (16 tiles) etc (Figure 40). The resolutions for the first five zoom levels are listed 

below (Table 2). A full list of zoom levels as well as more information on tiling are provided here.  

 
40: Tiling pyramids. (Source: maptiler.com) 

 

https://www.maptiler.com/google-maps-coordinates-tile-bounds-projection/#3/35.77/63.10


46 
 

Table 2: Zoom levels for map tiling. (Source: maptiler.com) 

Zoom level Resolution (meters 

/ pixel) 

Map Scale (at 96 dpi) Width and Height of map 

(pixels) 

0 156543.0339 1 : 591 658 710.90 512 

1 78271.51696 1 : 295 829 355.45 1024 

2 39135.75848 1 : 147 914 677.73 2048 

3 19567.87924 1 : 73 957 338.86 4096 

4 9783.939620 1 : 36978669.43 8,192 

5 4891.969810 1 : 18489334.72 16,384 

 

Vector tiling works similar, except that there are no pixels, hence no resolution or distinct zoom levels. 

Instead, vector tiles contain geometries and metadata that have been clipped to the tile area and are 

rendered and styled on the fly during loading (a website or else). Most web services use vector tiling 

nowadays.  

 

QGIS has built-in functions for tiling raster and vector data. An example of tiling the contents of your 

current map canvas is given here: 

 

• In the Processing Toolbox, find ‘Generate XYZ Tiles (MBTiles/Directory)’ MBTiles: Images are 

saved into one database file (preferred); Directory: Images are saved individually 

• Define the extent (leave empty if global/full extent) 

• Define min/max zoom level (Careful – many and higher zoom levels require a lot of time & CPU) 

• Select output directory and give a reasonable name 

 

You can use the tool/s ‘Write vector tiles' (MBTiles/XYZ) similar to the example above to create tiles for 

single vector layers. 

 

Tiling and pyramids building can also be achieved within the export dialogue of a Geotiff (.tiff) (Figure 

41). It then works on a layer basis and is recommended if you want to save large raster layers into smaller 

segments. To do so: 
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• Right-click on the raster you want to export, select ‘GeoTIFF’ as export format and enter a path 

to the directory 

• Under ‘Profile’, select ‘High Compression’ 

• You should see the table below populated with ‘COMPRESS’, ‘PREDICTOR’ and ‘ZLEVEL’. 

• Stay with the default settings 

•  with the ‘+’ sign, create a new table entry named ‘TILED’ and enter ‘YES’ as a value 

• Check the box under ‘Pyramids‘, select ‘Internal (if possible)’ as overview format to avoid 

creating a separate pyramid file and ‘Gauss’ as resampling method. 

• Check all level (=Zoom-level) boxes to cover all possible resolutions. You can also add custom 

levels if you like 

• And again, under ‘Profile’, select ‘High Compression’ (this is for the Pyramids file only) 

• Click ‘OK’ – Note: Depending on the size of your raster and the number of zoom levels, this 

might take a while! 

 

 
41: Tiling raster layer 
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Web Services 
 

You can load a broad variety of maps and datasets using Web Mapping Services (WMS). These services 

are standardised by the Open Geospatial Consortium (OGC) and are hosted on public servers 

accessible via specific protocols on the internet. Here is a good overview about the available protocols, 

below is a short intro:  

 

• WMS (Web Map Service): Provides general GIS data and maps in image form via web along 

with basic options like zooming and panning 

• WMTS (Web Map Tile Service): Provides pre-rendered and georeferenced map tiles  

• WFS (Web Feature Service): Provides geospatial features and extended manipulation options 

on vector data via web, such as deleting/creating features or enhanced query options 

• WCS (Web Coverage Service): Provides multi-dimensional raster data, such as satellite imagery 

or sensor data 

• WPS (Web Processing Service): Provides remote usage of geoprocessing tools via web 

• WCPS (Web Coverage Processing Service): Provides enhanced processing options for WCS 

(e.g. remote sensing/satellite data)  

 
 

Add WXS layers 
All mentioned services can be incorporated into GIS using URLs. There are basically two methods how 

to do so. As an example, here comes a short description using GEBCO 2022 WMS (a more detailed 

tutorial can be found here): 

 

• Under ‘Layer’ -> ‘Add Layer’ -> all the above-mentioned services are listed in the lower third of 

the dropdown menu  

• Select one of the services, e.g. ‘WMS/WMTS’  

• Click ‘New’ to establish a connection to a geodata host 

• Now enter a reasonable name (e.g. GEBCO 22) in the provided name field of the new window 

and the respective service address in die field below (Figure 42). For GEBCO, this URL is: 

https://www.gebco.net/data_and_products/gebco_web_services/web_map_service/mapserv

?SERVICE=WMS&REQUEST=GetCapabilities 

• Then click ‘OK’ and ‘Connect’ 

• You will see a list of available layers. Select one or more and click ‘Add’ (Figure 43) 

• Then you should be able to see the selected layer on the map canvas   

 

https://gisgeography.com/web-mapping-services-wms/
https://www.qgistutorials.com/en/docs/working_with_wms.html
https://www.gebco.net/data_and_products/gebco_web_services/web_map_service/mapserv?SERVICE=WMS&REQUEST=GetCapabilities
https://www.gebco.net/data_and_products/gebco_web_services/web_map_service/mapserv?SERVICE=WMS&REQUEST=GetCapabilities
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42: Create connection to WMS/WMTS service 
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43: WMS/WMTS layer dialogue 

 

The procedure described above is very similar for the other web services like WFS, WCS or XYZ. The 

latter is similar to WMTS and also allows to load raster tiles, but is not standardised by OGC. The use 

XYZ vs. WMTS etc. really depends on the purpose and the services provided.  

 

Useful WMS/WMTS URLs: 

Quick Map Service Catalogue: https://qms.nextgis.com/  

NASA Earth Observation Catalogue: https://neo.gsfc.nasa.gov/wms/wms?version=1.3.0  

 

If you’re looking for more or more specific services, ask Google or ChatGPT (: 

If you know what you’re looking for, you can also use specified search engines to find WXS services: 

 

Spatineo: https://directory.spatineo.com/  

GeoSeer: https://www.geoseer.net/  

List of XYZ tile services: https://xyzservices.readthedocs.io/en/stable/introduction.html  

 

A quick access list of the most basic available web service URLs for XYZ tiles is here: 

 

Google Maps: https://mt1.google.com/vt/lyrs=r&x={x}&y={y}&z={z}  

Google Satellite: https://www.google.cn/maps/vt?lyrs=s@189&gl=cn&x={x}&y={y}&z={z}  

Google Satellite Hybrid: https://mt1.google.com/vt/lyrs=y&x={x}&y={y}&z={z}  

Google Terrain: https://mt1.google.com/vt/lyrs=t&x={x}&y={y}&z={z}  

Google Roads: https://mt1.google.com/vt/lyrs=h&x={x}&y={y}&z={z}  

https://qms.nextgis.com/
https://neo.gsfc.nasa.gov/wms/wms?version=1.3.0
https://directory.spatineo.com/
https://www.geoseer.net/
https://xyzservices.readthedocs.io/en/stable/introduction.html
https://mt1.google.com/vt/lyrs=r&x=%7Bx%7D&y=%7By%7D&z=%7Bz%7D
https://www.google.cn/maps/vt?lyrs=s@189&gl=cn&x=%7Bx%7D&y=%7By%7D&z=%7Bz%7D
https://mt1.google.com/vt/lyrs=y&x=%7Bx%7D&y=%7By%7D&z=%7Bz%7D
https://mt1.google.com/vt/lyrs=t&x=%7Bx%7D&y=%7By%7D&z=%7Bz%7D
https://mt1.google.com/vt/lyrs=h&x=%7Bx%7D&y=%7By%7D&z=%7Bz%7D
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Open Street Map (OSM): https://tile.openstreetmap.org/{z}/{x}/{y}.png  

Open Weather: http://{s}.tile.openweathermap.org/map/{variant}/{z}/{x}/{y}.png?appid={apiKey}%0A  

 

 

Search QMS 
Another (and easier) method to look for web-based data is to use the ‘Quick Map Services (QMS)’ 

plugin. It is based on the Quick Map Service catalogue (see above). With this you don’t have to care 

about what type of service protocol is used, you just click the desired layer and add it:  

 

• If not yet done, activate the plugin under ‘Plugins’ -> ‘Manage and install plugins’ and under 

‘Installed’, check the box next to ‘QuickMapServices’ 

• You should then be able to see the ‘Search QMS’ dialogue and type anything you like in the 

search bar (Figure 44) 

 

 
44: Quick Map Services 

 

Where to find Data 
 

There are lots of data publicly available that can be downloaded and used as base maps or data layers. 

The following list does not claim to be complete, but hopefully is a good start: 

 

 

General 
Pangaea: https://www.pangaea.de/  

Seadatanet: https://cdi.seadatanet.org/search  

SHOM (French): https://data.shom.fr/donnees/catalogue/  

World Ocean Database: https://www.ncei.noaa.gov/access/world-ocean-database-

select/dbsearch.html 

Copernicus Marine Environment Monitoring Service (Global Ocean Satellite data): 

https://myocean.marine.copernicus.eu/data?view  

https://tile.openstreetmap.org/%7Bz%7D/%7Bx%7D/%7By%7D.png
https://www.pangaea.de/
https://cdi.seadatanet.org/search
https://data.shom.fr/donnees/catalogue/
https://www.ncei.noaa.gov/access/world-ocean-database-select/dbsearch.html
https://www.ncei.noaa.gov/access/world-ocean-database-select/dbsearch.html
https://myocean.marine.copernicus.eu/data?view
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ZENODO general purpose open-access repository: https://zenodo.org/  

DAM Marine Data Platform: https://marine-data.de/?site=home  

NOAA: https://www.ngdc.noaa.gov/ngdcinfo/onlineaccess.html  

ODIS Catalogie (Belgian): https://catalogue.odis.org/  

EEA Geospatial Data Catalogue/Map View: 

https://sdi.eea.europa.eu/catalogue/srv/eng/catalog.search#/map  

Copernicus: 

https://browser.dataspace.copernicus.eu/?zoom=5&lat=50.16282&lng=20.78613&themeId=DEFAULT

-

THEME&visualizationUrl=https%3A%2F%2Fsh.dataspace.copernicus.eu%2Fogc%2Fwms%2Fa91f72b5

-f393-4320-bc0f-

990129bd9e63&datasetId=S2_L2A_CDAS&demSource3D=%22MAPZEN%22&cloudCoverage=30&da

teMode=SINGLE  

ESA Earth Observation Catalogue: https://eocat.esa.int/sec/#data-services-area and https://fedeo-

client.ceos.org/  

Marine Geoscience Data System: https://www.marine-geo.org/index.php  

 

 

Geomorph 
Hydrothermal Vents: https://vents-data.interridge.org/ventfields-osm-map  

Sediment Thickness: https://ngdc.noaa.gov/mgg/sedthick/  

Seamount vector dataset: https://doi.pangaea.de/10.1594/PANGAEA.757564  

Sediment Trap data: http://usjgofs.whoi.edu/mzweb/data/Honjo/sed_traps.html 

Undersea Feature names: https://www.ngdc.noaa.gov/gazetteer/  

 

 

Bathymetry 
GEBCO: https://www.gebco.net/data_and_products/gridded_bathymetry_data/  

IHO/DCDB: https://maps.ngdc.noaa.gov/viewers/iho_dcdb/  

NOAA: 

https://noaa.maps.arcgis.com/apps/mapviewer/index.html?layers=0441041574c544dc9b6b8a513cad5

e95  

EMODnet: https://portal.emodnet-bathymetry.eu/  

GMRT: https://www.gmrt.org  

SRTM15+V2: https://catalog.data.gov/dataset/shuttle-radar-topography-mission-srtm-version-2  

Jamstec: http://www.godac.jamstec.go.jp  

 

Biodiversity 
Ocean Biodiversity Information System: https://obis.org/manual/access/  

World Register of Marine Species: http://www.marinespecies.org/index.php  

Ocean Biodiversity Information System Map: https://mapper.obis.org/  

Bio-ORACLE (Marine data layers for ecological modelling): https://bio-oracle.org/   

Quiet Ocean Project: https://iqoe.org/acoustic-data-portal  

https://zenodo.org/
https://marine-data.de/?site=home
https://www.ngdc.noaa.gov/ngdcinfo/onlineaccess.html
https://catalogue.odis.org/
https://sdi.eea.europa.eu/catalogue/srv/eng/catalog.search#/map
https://browser.dataspace.copernicus.eu/?zoom=5&lat=50.16282&lng=20.78613&themeId=DEFAULT-THEME&visualizationUrl=https%3A%2F%2Fsh.dataspace.copernicus.eu%2Fogc%2Fwms%2Fa91f72b5-f393-4320-bc0f-990129bd9e63&datasetId=S2_L2A_CDAS&demSource3D=%22MAPZEN%22&cloudCoverage=30&dateMode=SINGLE
https://browser.dataspace.copernicus.eu/?zoom=5&lat=50.16282&lng=20.78613&themeId=DEFAULT-THEME&visualizationUrl=https%3A%2F%2Fsh.dataspace.copernicus.eu%2Fogc%2Fwms%2Fa91f72b5-f393-4320-bc0f-990129bd9e63&datasetId=S2_L2A_CDAS&demSource3D=%22MAPZEN%22&cloudCoverage=30&dateMode=SINGLE
https://browser.dataspace.copernicus.eu/?zoom=5&lat=50.16282&lng=20.78613&themeId=DEFAULT-THEME&visualizationUrl=https%3A%2F%2Fsh.dataspace.copernicus.eu%2Fogc%2Fwms%2Fa91f72b5-f393-4320-bc0f-990129bd9e63&datasetId=S2_L2A_CDAS&demSource3D=%22MAPZEN%22&cloudCoverage=30&dateMode=SINGLE
https://browser.dataspace.copernicus.eu/?zoom=5&lat=50.16282&lng=20.78613&themeId=DEFAULT-THEME&visualizationUrl=https%3A%2F%2Fsh.dataspace.copernicus.eu%2Fogc%2Fwms%2Fa91f72b5-f393-4320-bc0f-990129bd9e63&datasetId=S2_L2A_CDAS&demSource3D=%22MAPZEN%22&cloudCoverage=30&dateMode=SINGLE
https://browser.dataspace.copernicus.eu/?zoom=5&lat=50.16282&lng=20.78613&themeId=DEFAULT-THEME&visualizationUrl=https%3A%2F%2Fsh.dataspace.copernicus.eu%2Fogc%2Fwms%2Fa91f72b5-f393-4320-bc0f-990129bd9e63&datasetId=S2_L2A_CDAS&demSource3D=%22MAPZEN%22&cloudCoverage=30&dateMode=SINGLE
https://browser.dataspace.copernicus.eu/?zoom=5&lat=50.16282&lng=20.78613&themeId=DEFAULT-THEME&visualizationUrl=https%3A%2F%2Fsh.dataspace.copernicus.eu%2Fogc%2Fwms%2Fa91f72b5-f393-4320-bc0f-990129bd9e63&datasetId=S2_L2A_CDAS&demSource3D=%22MAPZEN%22&cloudCoverage=30&dateMode=SINGLE
https://eocat.esa.int/sec/#data-services-area
https://fedeo-client.ceos.org/
https://fedeo-client.ceos.org/
https://www.marine-geo.org/index.php
https://vents-data.interridge.org/ventfields-osm-map
https://ngdc.noaa.gov/mgg/sedthick/
https://doi.pangaea.de/10.1594/PANGAEA.757564
http://usjgofs.whoi.edu/mzweb/data/Honjo/sed_traps.html
https://www.ngdc.noaa.gov/gazetteer/
https://www.gebco.net/data_and_products/gridded_bathymetry_data/
https://maps.ngdc.noaa.gov/viewers/iho_dcdb/
https://noaa.maps.arcgis.com/apps/mapviewer/index.html?layers=0441041574c544dc9b6b8a513cad5e95
https://noaa.maps.arcgis.com/apps/mapviewer/index.html?layers=0441041574c544dc9b6b8a513cad5e95
https://portal.emodnet-bathymetry.eu/
https://www.gmrt.org/
https://catalog.data.gov/dataset/shuttle-radar-topography-mission-srtm-version-2
http://www.godac.jamstec.go.jp/
https://obis.org/manual/access/
http://www.marinespecies.org/index.php
https://mapper.obis.org/
https://bio-oracle.org/
https://iqoe.org/acoustic-data-portal
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MBARI Mars sound snippets: https://freesound.org/people/MBARI_MARS/packs/19487/  

Sediment types: http://instaar.colorado.edu/~jenkinsc/dbseabed/kml/  

Deep Sea Sediment types: https://doi.pangaea.de/10.1594/PANGAEA.911692  

Sediment map: https://portal.gplates.org/cesium/?view=seabed  

AquaMap: https://www.aquamaps.org/search.php  

 

 

Institute/Regional Databases 
BSH: https://data.bsh.de/  

Flemish Ministry of Mobility and Public Works, Agency for Maritime and Coastal Services, Coastal 

Division: https://bathy.agentschapmdk.be/spatialfusionviewer/mapViewer/map.action  

Ireland: https://maps.marine.ie/infomarbathymetry/    

https://experience.arcgis.com/experience/50f0522dceaa4582a808558c0cbe8bb0  

Nordic Seas: https://dybdedata.kartverket.no/DybdedataInnsyn/  

Norway MAREANO: https://www.mareano.no/en/maps-and-data  

Ifremer: 

https://sextant.ifremer.fr/eng/Data/Catalogue#/map?owscontext=https:%2F%2Fwww.ifremer.fr%2Fse

xtant_doc%2Fsextant%2Fcontexte%2Fbathymetrie_emodnet_2016.xml  

Iceland: https://www.hafogvatn.is/en/research/seabed-mapping  

Canadian Hydrographic Service Non-Navigational (NONNA): https://data.chs-shc.ca/map; How-To-

Use: https://pacgis01.dfo-

mpo.gc.ca/FGPPublic/NONNA_100/CHS_NONNA_Data_Portal_Guidance_Document_en.pdf  

United Kongdom Hydrographic Office (UKHO): 

https://datahub.admiralty.co.uk/portal/apps/webappviewer/index.html?id=1d001f91ed114a5996e953

b5cdd62b06 and https://seabed.admiralty.co.uk/  

IEO Spanish Repo: http://datos.ieo.es/geonetwork/srv/eng/catalog.search#/home  

OSPAR Viewer: https://odims.ospar.org/  

British Oceanographic Data Centre BODC: 

https://www.bodc.ac.uk/data/bodc_database/nodb/search/  

Meeresumweltdatenbank (MUDAB): https://geoportal.bafg.de/MUDABAnwendung/  

Data from Observation Océanographique Villefranche sur mèr: http://www.obs-

vlfr.fr/cd_rom_dmtt/  

 

 

Human Activities 
Offshore Installations: https://www.ospar.org/work-areas/oic/installations  

Global Fishing Watch: https://globalfishingwatch.org/map/   

Marine Litter: https://litterbase.awi.de/interaction  

Skytruth Flaring Map: 

https://viirs.skytruth.org/apps/heatmap/flaringmap.html#zoom=6&lat=55.45365&lon=9.32216&offset

=15&chunk=2012  

Skytruth Oilspill Map: https://alerts.skytruth.org/issue/cerulean  

 

https://freesound.org/people/MBARI_MARS/packs/19487/
http://instaar.colorado.edu/~jenkinsc/dbseabed/kml/
https://doi.pangaea.de/10.1594/PANGAEA.911692
https://portal.gplates.org/cesium/?view=seabed
https://www.aquamaps.org/search.php
https://data.bsh.de/
https://bathy.agentschapmdk.be/spatialfusionviewer/mapViewer/map.action
https://maps.marine.ie/infomarbathymetry/
https://experience.arcgis.com/experience/50f0522dceaa4582a808558c0cbe8bb0
https://dybdedata.kartverket.no/DybdedataInnsyn/
https://www.mareano.no/en/maps-and-data
https://sextant.ifremer.fr/eng/Data/Catalogue#/map?owscontext=https:%2F%2Fwww.ifremer.fr%2Fsextant_doc%2Fsextant%2Fcontexte%2Fbathymetrie_emodnet_2016.xml
https://sextant.ifremer.fr/eng/Data/Catalogue#/map?owscontext=https:%2F%2Fwww.ifremer.fr%2Fsextant_doc%2Fsextant%2Fcontexte%2Fbathymetrie_emodnet_2016.xml
https://www.hafogvatn.is/en/research/seabed-mapping
https://data.chs-shc.ca/map
https://pacgis01.dfo-mpo.gc.ca/FGPPublic/NONNA_100/CHS_NONNA_Data_Portal_Guidance_Document_en.pdf
https://pacgis01.dfo-mpo.gc.ca/FGPPublic/NONNA_100/CHS_NONNA_Data_Portal_Guidance_Document_en.pdf
https://datahub.admiralty.co.uk/portal/apps/webappviewer/index.html?id=1d001f91ed114a5996e953b5cdd62b06
https://datahub.admiralty.co.uk/portal/apps/webappviewer/index.html?id=1d001f91ed114a5996e953b5cdd62b06
https://seabed.admiralty.co.uk/
http://datos.ieo.es/geonetwork/srv/eng/catalog.search#/home
https://odims.ospar.org/
https://www.bodc.ac.uk/data/bodc_database/nodb/search/
https://geoportal.bafg.de/MUDABAnwendung/
http://www.obs-vlfr.fr/cd_rom_dmtt/
http://www.obs-vlfr.fr/cd_rom_dmtt/
https://www.ospar.org/work-areas/oic/installations
https://globalfishingwatch.org/map/
https://litterbase.awi.de/interaction
https://viirs.skytruth.org/apps/heatmap/flaringmap.html#zoom=6&lat=55.45365&lon=9.32216&offset=15&chunk=2012
https://viirs.skytruth.org/apps/heatmap/flaringmap.html#zoom=6&lat=55.45365&lon=9.32216&offset=15&chunk=2012
https://alerts.skytruth.org/issue/cerulean
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Protection & Conservation 
Protected Planet: https://www.protectedplanet.net/en  

Natura 2000: https://natura2000.eea.europa.eu/  

MPA- Viewer: https://mpatlas.org/zones/  

Marine Ecoregions of the World (MEOW): https://www.worldwildlife.org/publications/marine-

ecoregions-of-the-world-a-bioregionalization-of-coastal-and-shelf-areas  

EUSeaMap: https://www.emodnet-seabedhabitats.eu/access-data/launch-map-viewer/  

MPA- Viewer (also based on mpatlas): https://marine-conservation.org/high-seas-protection-portal/  

Classify MPAs based on RBCS: https://www.classifympas.org/en/  

Biodiversity Hopespots Viewer: https://mission-blue.org/hope-spots/  

Key Biodiversity Areas (KNAs): https://www.keybiodiversityareas.org/kba-data 

HELCOM Baltic: http://maps.helcom.fi/website/mapservice/  

 

 

Marine Classifications 
Ecosystem Types of Europe - Marine Habitats: 

https://sdi.eea.europa.eu/catalogue/srv/eng/catalog.search#/metadata/aa791cf1-ead5-4364-b0c3-

4c54dc83c7e4  

Global Seafloor Feature Map (GSFM): https://www.bluehabitats.org/?page_id=9  Note: To 

download data, fill in this form: https://www.bluehabitats.org/?page_id=58  

Emodnet Seabed Habitats: https://www.emodnet-seabedhabitats.eu/access-data/download-

data/?linkid=eusm2019_group  

 

 

Editor’s choice: More Tools from the Processing Toolbox 
 

• ‘GDAL Warp (reproject)‘: Reproject raster layer (change geometry to different projection) 

• ‘Reproject layer’: Reproject raster layer (change geometry to different projection) 

• ‘Heatmap (Kernel Density Estimation)’: Create density (heatmap) raster of input point vector 

layer using kernel density estimation. 

• ‘Points to Path’: Connects points with lines (useful for survey planning) 

• ‘Extract vertices’: Opposite of ‘Points to Path’: Extracts the vertices as points from a line or a 

polygon layer. Also useful for survey planning. 

• ‘Array of offset parallel lines’: Creates copies of lines of a layer, by creating multiple offset 

versions of each feature with pre-set distance. Useful for survey planning. 

• ‘GDAL: Polygonize (raster to vector)’: creates features for each colour in raster. Useful if you 

e.g. have a raster file with different classes and want to convert it to vector. 

• ‘Select/Extract by xx’: Select or extract features from vector data based on area, attributes, 

expression or location. 

• ‘Fix geometries’: Attempts to create a valid version of a given vector file with invalid geometry 

without losing any of the input data. Useful if you work on vector data that have missing or 

https://www.protectedplanet.net/en
https://natura2000.eea.europa.eu/
https://mpatlas.org/zones/
https://www.worldwildlife.org/publications/marine-ecoregions-of-the-world-a-bioregionalization-of-coastal-and-shelf-areas
https://www.worldwildlife.org/publications/marine-ecoregions-of-the-world-a-bioregionalization-of-coastal-and-shelf-areas
https://www.emodnet-seabedhabitats.eu/access-data/launch-map-viewer/
https://marine-conservation.org/high-seas-protection-portal/
https://www.classifympas.org/en/
https://mission-blue.org/hope-spots/
https://www.keybiodiversityareas.org/kba-data
http://maps.helcom.fi/website/mapservice/
https://sdi.eea.europa.eu/catalogue/srv/eng/catalog.search#/metadata/aa791cf1-ead5-4364-b0c3-4c54dc83c7e4
https://sdi.eea.europa.eu/catalogue/srv/eng/catalog.search#/metadata/aa791cf1-ead5-4364-b0c3-4c54dc83c7e4
https://www.bluehabitats.org/?page_id=9
https://www.bluehabitats.org/?page_id=58
https://www.emodnet-seabedhabitats.eu/access-data/download-data/?linkid=eusm2019_group
https://www.emodnet-seabedhabitats.eu/access-data/download-data/?linkid=eusm2019_group
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broken geometries (like e.g. ring enclosures etc.). If a corrupt shapefile doesn't let you do 

anything with it, this tool helps! 

• ‘Buffer’: Computes a buffer area for all the features in an input layer, using fixed or dynamic 

distance. There are multiple buffer tools out there, check them out! Useful e.g. to estimate 

multibeam coverage. Note that this tool needs a projected input layer (UTM is most accurate 

at small areas) if distances are given in metric units (meters, km etc.) 

• ‘Dissolve Features’: Merges multiple features of a vector file based on attribute selection. 

Useful for example, if you have a line file with many pieces that belong to the same line and 

you want to make it one continuous line.  

 

 

Editor’s choice: More Plugins 
 

The following list doesn’t claim to be exhaustive. You can find all top-rated plugins here. 

• ‘Value Tool’: Display values when hovering over map from all layers in project. Very useful for 

data exploration. 

• ‘Point Sampling Tool’: Collect attributes (polygon) and/or values (raster) from multiple layers at 

specific sampling points.  

• ‘Cruise Tools’: An entire workbench for cruise planning written by AWI (Alfred Wegener 

Institute). Contains several stand-alone tools. Handy if you would like to plan surveys exactly 

like the tool proposes.  

• ‘Lat Lon Tool’: This Plugin basically can do anything concerning coordinates: Capture 

coordinates, zoom to coordinates, add points based on given coordinates, conversion etc. 

Useful for a lot of stuff. 

• ‘Quick Map Services NextGIS’: Provides a list of (web)services and lets you search for datasets 

and base maps. These can be added to the map canvas. 

• ‘Marine Tools’: Collection of tools for analysis and interpretation of marine data (including 

applications like the Benthic Terrain Modeller and OBIA, known from the ArcGIS community). 

Find out more details here.  

 

 

 

 

Congratulations, you made it! This is 
 

------------------------------------ THE END --------------------------------------- 

https://plugins.qgis.org/plugins/most_voted/
https://plugins.qgis.org/plugins/marinetools/#plugin-about

